
At last!  We have an announcement.  Together with CPA Australia, SumProduct is proud to announce the Excel MVP conference is returning in 2017 
to Australia and New Zealand.  Previously known as the Excel Summit South, it’s being re-branded as:

That’s right: together with CPA Australia, we’re giving you access to 
training by seven of the world’s leading Excel gurus (our own Liam Bastick, 
as well as Chandoo, Roger Govier, Inge Hawighorst, Jon Peltier, Ken Puls 
and Mynda Treacy), Microsoft Most Valuable Professionals, so you can 
learn to unlock the true potential of your data.

Over two captivating days, discover how advancing your Excel knowledge 

can help you stand out from the crowd and achieve accounting and 
financial excellence.

Earlybird prices are available right now.  For more details, you my view the 
full program and book at www.cpaaustralia.com.au/unlockexcel.  Hope to 
see you there!

NEWSLETTER #51 - January 2017

Looking for a life more ordinary? Maybe you’ll have to wait for 
Microsoft to invent the MEDIOCRE function (although we have certainly come across some models that fit that bill…), but we do focus on 
some decidedly AVERAGE-looking functions this month.

This month, we have two events to announce: our very own Unlock Excel is coming to Australia and New Zealand, whilst  
our sister convention, the Amsterdam Excel Summit reconvenes too.  There will be more announcements down the track 
 – watch out London and New York!

With the usual Power Query Pointers, the A to Z of Excel Functions and a Keyboard Shortcuts session that’s sure to be a 
pane, there should be something for everybody!

Until next month.
Liam Bastick, Managing Director, SumProduct

Unlock Excel
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www.sumproduct.com  |  www.sumproduct.com/thought

UNLOCK 
EXCEL
POWERED FOR ACCOUNTING 
AND FINANCE 

MELBOURNE 1 – 2 MAY 2017

BRISBANE 4 – 5 MAY 2017

SYDNEY 8 – 9 MAY 2017

AUCKLAND 11 – 12 MAY 2017

Access seven of the world’s leading Excel gurus,  
named Microsoft’s Most Valuable Professionals,     
over two captivating days and learn how to 
unlock the true potential of Excel.

Discover how advancing your Excel knowledge can help  
you stand out from the crowd and achieve accounting and  
financial excellence. 

VIEW PROGRAM AND BOOK NOW 
cpaaustralia.com.au/unlockexcel

EARLY BIRD PRICES AVAILABLE!

https://www.cpaaustralia.com.au/training-and-events/conferences/unlock-excel
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Each month we’ll reproduce one of our articles on Power Query (Excel 
2010 and 2013) / Get & Transform (Excel 2016) from www.sumproduct.
com/blog.  If you wish to read more in the meantime, simply check out 
our Blog section each Wednesday.    
Power Query is a free add-in ETL (extract, transform and load) tool for 
users of Excel 2010 (Professional Plus with Software Assurance version 
only) and 2013 (all versions), where it has its own place on the Ribbon, 
and is now fully integrated into Excel 2016, where it can be found on the 
‘Data’ tab under ‘Get & Transform’.  So far Power Query is only available 
for Windows users.

Users of Excel 2016 will have Power Query by default. Users of Excel 
2010 and 2013 can download Power Query from the Microsoft website.  
Before downloading, we need to know the bit version of the installed 
Excel, which will either be 32-bit (x86) or 64-bit (x64). The information 
about the version of Excel and the bit version can be found on the File 
tab of Excel 2010 in the help section. In Excel 2013, the information we 
need is in the Account section of the File tab, under the ‘About Excel’ 
button.

Armed with the version and bit version, the country specific Microsoft download page is easy to navigate. 
Once installed, all that remains is to make sure that the Excel Options on the File tab are configured to allow Power Query to be accessed. On the  
Add-ins section of Excel Options, the ‘Manage’ drop-down allows ‘COM Add-ins’ to be selected:

The sub-screen that pops up enables available COM add-ins to be activated, and this sub-screen is the place to go if the Power Query tab ever 
‘disappears’ (it can happen)!

Power Query Pointers
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Once Power Query is installed, be aware that Microsoft often releases 
updates, usually on a monthly basis – try searching ‘updates for Get 
& Transform in Excel 2016 and the Power Query add-in’ to see the 
latest updates available.  Depending on how Windows is configured, 
notifications for Power Query can appear when Excel is opened.  There 

is also an in-screen Update feature which can be viewed and activated 
from within Excel on the Power Query tab (or in the Get and Transform 
tab for Excel 2016).  There will be a requirement to close and reopen 
Excel in order to complete most updates. 

We thought AVEDEV was an Indian cricket captain from the 1980’s.  Apparently not.  However, the definition of this statistical function may knock 
you for six: it returns the average of the absolute deviations of data points from their mean, i.e. AVEDEV measures the variability in a data set.

It’s not quite as complicated as it sounds.  If you have a set of numbers and calculated their average – the mean – and then for each value, took the 
average of how far each value was from the average (ignoring whether the distance was positive or negative), you would calculate this value.  It’s not 
as statistically robust as calculating the standard deviation, but it is probably a better understood measure.

The AVEDEV function employs the following syntax to operate: 

AVEDEV(number1, [number2], ...)

The AVEDEV function has the following arguments:

	 •	number1, number2, ...: number1 is always required, but subsequent numbers are optional.  The function takes between one and 255 arguments  
		  for which you wish the average of the absolute deviations.  You can also use a single array or a reference to an array instead of arguments 	
		  separated by commas assuming this is your function delimiter.

It should be further noted that: 

	 •	AVEDEV is influenced by the unit of measurement in the input data 
	 •	Arguments must either be numbers or be names, arrays, or references that contain numbers 
	 •	 Logical values and text representations of numbers that you type directly into the list of arguments are counted 
	 •	 If an array or reference argument contains text, logical values, or empty cells, those values are ignored; however, cells with the value zero are  
		  included 
	 •	 The equation for average deviation is: 
 

It’s easier to follow if you work your way through the following example: 

The A to Z of Excel Functions: AVEDEV
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This is quite an ordinary function; indeed, it is distinctly average.  Returns the average (arithmetic mean) of the arguments.  For example, if the range 
A1:A20 contains numbers, the formula =AVERAGE(A1:A20) returns the arithmetic mean of those numbers, including counting zeros.

The AVERAGE function measures what is known as “central tendency”, which is the location of the centre of a group of numbers in a statistical 
distribution.  There are three common measures of central tendency:

	 •	Average: the arithmetic mean, calculated by adding a group of numbers and then dividing by the count of those numbers.  For example, the 	
		  average of 2, 3, 3, 5, 7, and 10 is 30 divided by 6, which is 5 
	 •	Median: the middle number of a group of numbers; that is, half the numbers have values that are greater than the median, and half the 	
		  numbers have values that are less than the median. For example, the median of 2, 3, 3, 5, 7, and 10 is 4.  If the number of values in the 	
		  selection is an even number, the median is defined as the midpoint between the two central numbers 
	 •	Mode: the most frequently occurring number in a group of numbers.  For example, the mode of 2, 3, 3, 5, 7, and 10 is 3.

For a symmetrical distribution of a group of numbers, these three measures of central tendency are all the same.  For a skewed distribution of a 
group of numbers, they can be different.

The AVERAGE function employs the following syntax to operate:

AVERAGE(number1, [number2], ...)

The AVERAGE function has the following arguments:

	 •	 number1: this is required.  The first number, cell reference, or range for which you want the average 
	 •	 number2, …: this is optional.  Additional numbers, cell references or ranges for which you want the average, up to a maximum of 255 in total.

It should be further noted that:

	 •	Arguments can either be numbers or names, ranges, or cell references that contain numbers 
	 •	 Logical values and text representations of numbers that you type directly into the list of arguments are counted 
	 •	 If a range or cell reference argument contains text, logical values, or empty cells, those values are ignored; however, cells with the value zero 	
		  are included 
	 •	Arguments that are error values or text that cannot be translated into numbers cause errors 
	 •	 If you want to include logical values and text representations of numbers in a reference as part of the calculation, use the AVERAGEA function 
	 •	 If you want to calculate the average of only the values that meet certain criteria, use the AVERAGEIF or AVERAGEIFS functions (please see below).

You should bear in mind that when you average cells, there is a difference between empty cells and those containing the value zero.  If you have 
cleared the ‘Show a zero in cells that have a zero value’ check box in the Excel Options dialog box in Excel, you may not realise zeros are being 
included in calculating the average.  To locate the ‘Show a zero in cells that have a zero value’ check box, go to File -> Options -> Advanced and look 
under ‘Display options for this worksheet’.

Consider the following example:

Similar to the AVERAGE function, this function calculates the average (arithmetic mean) of the values in the list of arguments, i.e. the key difference 
is that this works on the value of the argument rather than assume the argument is a number.  Essentially, this means that the AVERAGEA function 
is different from the AVERAGE function in that it treats TRUE as a value of 1 and FALSE as a value of 0.

The AVERAGEA function measures what is known as “central tendency”, as discussed above.  The AVERAGEA function employs the following syntax 
to operate:

AVERAGEA(value1, [value2], ...)

The AVERAGEA function has the following arguments:

	 •	value1: this is required 
	 •	value 2, …: subsequent values are optional.  You can have between one and 255 cells, ranges of cells.

The A to Z of Excel Functions: AVERAGE

The A to Z of Excel Functions: AVERAGEA
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You should bear in mind that when you average cells, there is a difference between empty cells and those containing the value zero.  If you have 
cleared the ‘Show a zero in cells that have a zero value’ check box in the Excel Options dialog box in Excel, you may not realise zeros are being 
included in calculating the average.  To locate the ‘Show a zero in cells that have a zero value’ check box, go to File -> Options -> Advanced and look 
under ‘Display options for this worksheet’.

Another example: 

This function returns the average (arithmetic mean) of all cells in a range that meet a given criterion.  It is the “average” equivalent of SUMIF.

The AVERAGEIF function is yet another that measures “central tendency.  The AVERAGEIF function employs the following syntax to operate:

AVERAGEIF(range, criterion, [average_range])

The AVERAGEIF function has the following arguments:

	 •	 range: this is required.  One or more cells to use for the criterion, including numbers, names, arrays or references that contain numbers 
	 •	 criterion: this is also required.  The criterion in the form of a number, expression, cell reference, or text that defines which cells are averaged.  	
		  For example, criteria can be expressed as 32, "32", ">32", "apples", B4 or “>=”&B4. 
	 •	average_range: Optional. The actual set of cells to average.  If omitted, range is used.  Be careful though: if an average_range is specified 	
		  that is not of the same dimensions as range, the average_range will be modified by using the top, left cell specified in the range but then use 	
		  the dimensions that correspond in size and shape to range, e.g.

It should also be noted that:

	 •	 Cells in range that contain TRUE or 	
		  FALSE are ignored 
	 •	 If a cell in average_range is an empty 	
		  cell, AVERAGEIF ignores it 
	 •	 If range is a blank or text value, 		
		  AVERAGEIF returns the #DIV0! error 	
		  value 
	 •	 If a cell in criteria is empty, AVERAGEIF 	
		  treats it as a zero value 
	 •	 If no cells in the range meet the criteria, 	
		  AVERAGEIF returns the #DIV/0! error 	
		  value 
	 •	 You can use the wildcard characters, 	
		  question mark (?) and asterisk (*), in 	
		  criteria.  A question mark matches any 	
		  single character; an asterisk 		
		  matches any sequence of characters.   
		  If 	you want to find an actual question 	
		  mark or asterisk, type a tilde (~) before 	
		  the character.

To illustrate: 

The A to Z of Excel Functions: AVERAGEIF

≥
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Similar to AVERAGEIF, this function returns the average (arithmetic mean) of all cells that meet multiple criteria.  It is the “average” equivalent of SUMIFS.

The AVERAGEIFS function is our final function this month that measures “central tendency”.  The AVERAGEIFS function employs the following 
syntax to operate:

AVERAGEIFS(average_range, criterion_range1, criterion1, [criterion_range2, criterion2], ...)

The AVERAGEIFS function has the following arguments:

	 •	average_range: this is required.  One or more cells to average, including numbers, names, arrays, or references that contain numbers 
	 •	 criterion_range1: this is required, consisting of one or more cells to use for the criterion1 and can include numbers or names, arrays, or 	
		  references that contain numbers 
	 •	 criterion_range2,…: up to a further 126 ranges (with associated criteria) are optional 
	 •	 criterion1: this is also required.  The criterion in the form of a number, expression, cell reference, or text that defines which cells are 	
		  averaged.  For example, criteria can be expressed as 32, "32", ">32", "apples", B4 or “>=”&B4. 
	 •	 criterion2, ...: this is required if the corresponding optional criterion_range is invoked.  Syntax should be similar to that used for criterion1.

It should be further noted that:

	 •	 If average_range is a blank or text value, AVERAGEIFS returns the #DIV0! error value 
	 •	 If a cell in a criteria range is empty, AVERAGEIFS treats it as a zero value 
	 •	 Cells in range that contain TRUE evaluate as 1; cells in range that contain FALSE evaluate as zero 
	 •	 Each cell in average_range is used in the average calculation only if all of the corresponding criteria specified are TRUE for that cell 
	 •	Unlike the range and criterion arguments in the AVERAGEIF function, in AVERAGEIFS each criterion_range must be the same size and shape 	
		  as average_range 
	 •	 If cells in average_range cannot be translated into numbers, AVERAGEIFS returns the #DIV0! error value 
	 •	 If there are no cells that meet all the criteria, AVERAGEIFS returns the #DIV/0! error value 
	 •	 You can use the wildcard characters, question mark (?) and asterisk (*), in criteria.  A question mark matches any single character; an asterisk 	
		  matches any sequence of characters.  If you want to find an actual question mark or asterisk, type a tilde (~) before the character.

Here’s our final example for this month: 

The A to Z of Excel Functions: AVERAGEIFS

This month’s question proves professionals working in the modelling industry don’t want dates (groan! – Ed.).

In a large workbook, that has been in use for some time, I’m suddenly finding practically the entire workbook has formatted every cell 
as a date.  I didn’t change anything!  How can I get my spreadsheet to look “normal” again?

“Normal” is the operative word here.  This bug raises its head a little too frequently for our liking and first emanated in Excel 2007.  
It’s to do with the default style in Excel, called ‘Normal’ ironically.  Apparently, the number format in the ‘Normal’ style inexplicably 
changes from ‘General’ to a particular date format ([$-409]m/d/yy h:mm AM/PM;@).  Past Excel MVP Ron Coderre speculated this 
may be triggered by sharing an Excel workbook given anecdotal evidence.

The fix is very simple:

•	 Click on any cell in any worksheet that contains one of these incorrectly formatted cells 
•	 On the ‘Home’ tab, in the ‘Styles’ group, click on the down arrow in the bottom right-hand corner of the ‘Styles’ window  
	 (ALT + H + J) and right click on the ‘Normal’ style to select ‘Modify…’ (DO NOT use the keyboard shortcut ALT + H + J + M as this 	
	 will merge styles from another workbook) viz.

Reader’s Question
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	 •	 Click the ‘Format’ button in the 	 	
	 	 resulting ‘Style’ dialog box

	 •	On the ‘Number’ tab of the ‘Format Cells’ dialog box, change the ‘Category:’ 	
	 	 back to ‘General’ from ‘Date’.

	 •	 Click the ‘OK’ button twice	
	 •	Done!

Hopefully, this problem will disappear eventually.  Presently, we know of no 
update or patch other than this workaround that fixes this annoying – and 
persistent – bug. 
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SumProduct is pleased to announce that our MD, Liam Bastick, 
has been re-awarded Microsoft’s Most Valuable Professional 
(MVP) award for Excel for 2017.  This award recognises 
exceptional technical community leaders from around the world 
who voluntarily share their high quality, real world expertise 
with others. Microsoft MVPs are a highly select group of experts 
representing technology's best and brightest who share a deep 
commitment to community and a willingness to help others.

Worldwide, there are over 100 million participants in technical 
communities; of these participants, there are fewer than 4,000 

active Microsoft MVPs. In Excel, c.100 people have received this 
award.

Microsoft’s MVP Award evaluates technical expertise and 
voluntary community contributions for the past year, considering 
the quality, quantity and level of impact of contributions. It’s 
a difficult award to attain and just as difficult to retain.  This is 
Liam’s fourth consecutive award.

At SumProduct, you can rely on our experience and willingness 
to help.

Yes, it’s time for those discussions again.  Excel Microsoft MVPs Jan Karel (pictured left above) and 
Tony de Jonker (not left) are busily scheduling this year’s Amsterdam Excel Summit.  For our readers 
based in Europe, the format of this year’s sessions have not yet been finalised, but as always, it will 
be presented by various MVPs from around the globe on Tuesday 18 April and Wednesday 19 April.  

Technically, Tuesday 18th will be a “pre-conference masterclass” with the Summit the next day.  Topics 
seem to be focusing on Power BI, Power Pivot and Power Query this year, reflecting the continuing end 
users’ moves toward these Business Intelligence tools.

This Summit has been an annual event since 2014, with each one bigger and better than its precedent 
http://topexcelclass.com/index.php/amsterdam-excel-summit/.  Hope to see some of you there!

MVP 2017

Amsterdam Excel Summit: April 18 and 19, 2017

Upcoming SumProduct Training Courses

Location Course Date Duration

Melbourne Financial Modelling for Mergers and Acquisitions 6th - 9th Feb 2017 4 days

Sydney Excel Tips and Tricks 6th Feb 2017 1 day

Sydney Financial Modelling 7th - 8th Feb 2017 2 days

Melbourne Power Pivot, Power Query and Power BI 20th - 22nd Feb 2017 3 days

Toronto Financial Modelling 6th - 7th Mar 2017 2 days

Toronto Power Pivot, Power Query and Power BI 8th - 10th Mar 2017 3 days

New York Financial Modelling 13th - 14th Mar 2017 2 days

New York Power Pivot, Power Query and Power BI 15th - 17th Mar 2017 3 days

Sydney Power Pivot, Power Query and Power BI 20th - 22nd Mar 2017 3 days

Melbourne Financial Modelling 27th - 28th Mar 2017 2 days

Sydney Visual Basic for Applications 4th - 4th Apr 2017 1 day

Sydney Excel Tips & Tricks 10th - 10th Apr 2017 1 day

Sydney Financial Modelling 20th - 21st Apr 2017 2 days

Melbourne Excel Tips & Tricks 29th - 29th May 2017 1 day

Melbourne Financial Modelling 30th - 31st May 2017 2 days

Melbourne Introduction to Financial Forecasting 1st - 1st Jun 2017 1 day

Perth Excel Tips & Tricks 7th - 7th Jun 2017 1 day

Perth Financial Modelling 8th - 9th Jun 2017 2 days

Sydney Excel Tips & Tricks 13rd - 13rd Jun 2017 1 day

Sydney Financial Modelling 14th - 14th Jun 2017 1 day

Melbourne Power Pivot/ Power Query/ Power BI 19th - 21st Jun 2017 3 days

Brisbane Excel Tips & Tricks 26th - 26th Jun 2017 1 day

Brisbane Financial Modelling 27th - 28th Jun 2017 2 days

Melbourne Excel Tips & Tricks 3rd - 3rd Jul 2017 1 day

Melbourne Financial Modelling 4th - 5th Jul 2017 2 days

Sydney Visual Basic for Applications 10th - 10th Jul 2017 1 day
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Sydney Address:	 SumProduct Pty Ltd, Suite 52, Level 10, 88 Pitt Street, Sydney, NSW 2000
New York Address:	 SumProduct Pty Ltd, 48 Wall Street, New York, NY, USA 10005
London Address:	 SumProduct Pty Ltd, Office 7, 3537 Ludgate Hill, London, EC4M 7JN, UK
Melbourne Address:	SumProduct Pty Ltd, Level 9, 440 Collins Street, Melbourne, VIC 3000
Registered Address:	SumProduct Pty Ltd, Level 6, 468 St Kilda Road, Melbourne, VIC 3004

Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 		
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from
http://www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month we decided we’d continue 
going through the function keys – this time, with the F6 function key:

There are over 540 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file a
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Keystroke What it does

F6 Next Pane

ALT + F6 Switch to VBA Integrated Development Environment (if already open)

CTRL + F6 Next Window / Workbook

SHIFT + F6 Previous Pane

CTRL + SHIFT + F6 Previous Window / Workbook

Have you heard about the 
SumProduct Referral programme? 
If you successfully introduce us to a 
client we will pay you 10% of the net 
profits of the engagement won upon 
receipt of client payment. Sounds like 
a pretty good deal to us!

Terms and conditions apply.  Referrer 
must be over 18 years of age, able 
to issue an invoice and not be an 
employee, director, agent or other 
related party of the client engaged.  
For further information, drop us a line 
at  contact@sumproduct.com.  We 
hope to hear from you!

Referral Programme

Sydney Excel Tips & Tricks 31st - 31st Jul 2017 1 day

Sydney Financial Modelling 1st - 2nd Aug 2017 2 days

Perth Power Pivot/ Power Query/ Power BI 7th - 9th Aug 2017 3 days

Adelaide Excel Tips & Tricks 14th - 16th Aug 2017 3 days

Adelaide Financial Modelling 15th - 15th Aug 2017 1 day

Melbourne Mergers and Acquisitions 21st - 24th Aug 2017 4 days

Brisbane Power Pivot/ Power Query/ Power BI 28th - 30th Aug 2017 3 days

Melbourne Excel Tips & Tricks 4th - 4th Sep 2017 1 day

Melbourne Financial Modelling 5th - 6th Sep 2017 2 days

Melbourne Power Pivot/ Power Query/ Power BI 12nd - 14th Sep 2017 3 days

Sydney Excel Tips & Tricks 25th - 25th Sep 2017 1 day

Sydney Financial Modelling 26th - 27th Sep 2017 2 days

Sydney Power Pivot/ Power Query/ Power BI 16th - 18th Oct 2017 3 days

Melbourne Excel Tips & Tricks 23rd - 23rd Oct 2017 1 day

Melbourne Financial Modelling 24th - 25th Oct 2017 2 days

Sydney Visual Basic for Applications 6th - 6th Nov 2017 1 day

Sydney Excel Tips & Tricks 13rd - 13rd Nov 2017 1 day

Sydney Financial Modelling 14th - 15th Nov 2017 2 days

Melbourne Power Pivot/ Power Query/ Power BI 4th - 6th Dec 2017 3 days

Melbourne Excel Tips & Tricks 11st - 11st Dec 2017 1 day

Melbourne Financial Modelling 12nd - 13rd Dec 2017 2 days

mailto:contact@sumproduct.com
http://www.sumproduct.com
http://www.sumproduct.com
mailto:newsletter@sumproduct.com
mailto:contact@sumproduct.com
mailto:training%40sumproduct.com?subject=
http://www.sumproduct.com/training
http://www.sumproduct.com/thought/keyboard-shortcuts
http://www.sumproduct.com
mailto:contact%40sumproduct.com?subject=

